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Background

Word uses the template "Normal.dotx" as default if you begin a new document.
In this default template all common styles like headings, lists or captions are
already available.

However, it makes sense to use your own user defined template. In such a
template you define all needed paragraph styles (and character styles) and
axesWord® document settings only once. After that you can use your template
repeatedly and you can work with your customized styles.

We have already done this work and have created our axes\Word master template
for you (you can download it from the site Instructions & manuals for axes\Word,
axesSlide & axesPDF).

This template contains styles for:

= Headings (Level 1-9)

= Text paragraphs

= Multilevel lists with bullet points

= Multilevel lists with numbering

= List Continues

= Row and column headers for tables (row and column headers of level 1 - 5)
= Data cells

= Links
= Footnotes
= Quotes

= Captions
= Table of contents

Appropriate roles were assigned to all styles so that you immediately get an
accessible PDF/UA document when converting your Word document to a PDF
document by using axesWord®.
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Preparing Word: Useful views and settings

Show paragraph marks and formatting symbols

Click in the Home tab in the Paragraph command group on the j-symbol (top
right).

iEY R == 49

Paragraph N

Figure 2: "Paragraph" command group

Reason

You can see in the document view which paragraph styles and formatting
symbols were used.

Show "Styles” task pane

Click in the Home tab in the Styles command group on the dialog box launcher
in the right corner - the Styles task pane will be shown on the right-hand side.

Reason

You can see which styles are available and also which style was assigned to a
paragraph.

Show "Navigation” task pane

Activate the Navigation Pane check box in the Show command group in the
View tab.

Ruler
[] Gridlines

Navigation Pane

Show

Figure 3: "Show" command group

The Navigation task pane will be shown on the left-hand side.
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Reason

You can see which headings were defined and how the document is
structured.

When you prepared these three settings you will see the following view:
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Figure 4: Word window with the task panes "Navigation" (left hand side) and "Styles" (right hand
side)
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Working with the master template

Double click on the master template (.dotx) — this is a very easy way to start a new
document (.docx).

At the outset save your document with an appropriate new file name.

Document title

Define the document title in the document properties right at the beginning of
your work. Click on the File tab, select the Info option and enter the document
title in the Title text box.

Properties v

Size 836KB
Pages 11
Words 346

Total Editing Time 0 Minutes

Title [ Document title ]
Tags Add a tag
Comments Add comments

Figure 5: Document properties

Define language

Define the language of your content by selecting (all) content and clicking on the
language in the status line at the bottom on the left-hand side. In the Language
dialog box, you can select the corresponding language.
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Language ? X
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¥ English (United Kingdom)
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The speller and other proofing tools automatically use
dictionaries of the selected language, if available.

() Do not check spelling or grammar

() Detect language automatically

Set As Default Cancel

Figure 6: "Language" dialog box

Title and subtitle

Start your document and enter title and subtitle. You can simply overwrite the
words "Title" and "Subtitle" on the title page.
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Figure 7: Title and subtitle
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Headings and paragraphs

Use the paragraph styles "Heading 1", "Heading 2" and so on according to the
structure of your document and take care that you do not skip any level.

Reason

Headings are important for quick navigation within your document -
especially for users of assistive technologies (AT).

Now you can type headings and paragraphs. Again, you can just overwrite the
existing headings and paragraphs.

P search - .
File Home axesWord Insert Draw Design Layout References Mailings Review View Developer Help Acrobat O Comments | [ &7 Editing | [ERIEERY
= 5 Breaks + Indent Spacing H [E= align ~
H &5 E:* - e o By By JE
Margins Orientaton  Size Columns < LN Numbers 2= Left [ o[ = pefore: |12t ) Selection ‘T
v v v b Hyphenation ~ =< Right: 0" Oz afer [12pe . Pane g
Page Setup [ Paragraph ] Arrange ~
4 1 2 El 4 5 &
Navigation v ox |t 0 Styles voX
arch document Jols Normal
Headings  Pages  Results . .My first-Heading-1] No Spacing
B - The-first-paragraph-in-this-documenty] Headmg 1 ‘i
entent -
My first Heading 1 . Heading 2
+ Myt Hoadng : -My-Heading 2q g
4 My Heading 2 .
Mo Hesding 3 - Heading 3
¥ Fleading - Paragraph-which-belongs-to-heading-2y
4 Tables . Heading 4
Assign Data cells by using customi..
Create accessible tables by using.. o . Quotation™] Heading 5
Figures and charts -
4 Lists - - List
Lists with bullet points . . My-Heading-3 i
i . v a3 — List2
ists with numbering .
s This is-the-third-paragraph . List3
And what about accessible footnotes? :
: o List4
“ - List5
B Show Preview
(] Disable Linked styles
“ Al (A [A] [ options..
Page3aof& dof 6wards ([  English (Unitec States)  Text Preciictions: On [ 10 Accessibility: Good to go ] Facus B - 1 + 100%

Figure 8: Headings and paragraphs

For further headings and paragraphs start a new paragraph, e.g. the new
paragraph "This shall become a Heading 4".
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Figure 9: Headings and paragraphs — new heading 4

Afterwards assign the corresponding paragraph style to this paragraph by clicking
on "Heading 4" in the Styles task pane. It is sufficient if you position the cursor in
the paragraph (i. e. you do not have to select the whole paragraph when
assigning a paragraph style).
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Figure 10: Headings and paragraphs - Heading 4 style was assigned
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Please use hard line breaks and soft line breaks correctly:

= Hard line break (Return key): begin a new paragraph.
= Soft line break (Shift + Return-key): begin a new line within a paragraph.

Tables

Overwrite the caption of the table, the table headers and the data cells with your
values. You can also delete rows or columns or insert new ones. Use right-click in a
row or column and select Insert menu option or Delete menu option.

£ search

File Home axesWord Insert Draw Design Layout References Mailings Review View Developer Help Acrobat Table Design  Table Layout ‘D(Gmmer\t_stEdltmg u\

Iy select ~ [Z] Draw Table E E’I\ﬂ B insert Row Below B vegecels | [oer jo BEEe A E Q\L [E] Repeat Header Rows
X ( = ’

i 1 ® k= i = e =
(S view Gridiines || [%jraser beite | Insert Row CH Insert Column Left [ split cells = 8 BEE o (& Convertto Text
Properties N Above [ Insert Column Right 3 Split Table S AutoFit v Direction Margins fi Formula
& Prop g 3 Spl =]
Table Draw Rows & Columns. M Merge Call size w Alignmant Data ~
- o B - TR T S 4E 5 B 6B
Navigation vooX Styles Voo X
Search document Jo )
intense Emphasis
- : .Tablesq
Headings  Pages  Results Intense Quole
— g able-1-Example fora-simple tablef] INTENSE REFERENCE

4 My first Heading 1 Mondayn Tuesdayn Wednesdayn Thursdayz Fridayn 1 Quote

4 My Heading 2 o
4 My Heading 3 Meeting-A= &= = & (=1 Strong
This paragraph shall becor.. o
4 Tables o o o o H SuBTLE REFERENCE
Create accessible tables by using..
1 Header — Level 1

Figures and charts

4 Lists

- Header — Level 2
Lists with bullet points 11:000 -
Lists with numbering o ] o ] o Header — Level 3
Link
12:00m =
2 - Header — Level 4

] Header — Level &
. o -] o -] =1 |
B Header | Level 1
. O
B show Preview
] Disable Linked Styles
A& [A] | optiens. |
Pagedofs 309 words [ Engiish (United States)  Text Precictions: On 3 1% Accessibiity: Good to go T Focus N i + 0%

Figure 11: Example of a table

Figures and diagrams

Decide whether your graphics are relevant content or just decorative elements.
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Figure 12: Photo of a forest

Relevant content

Anchor your figures in case they do not use the layout option In Line with Text.
Click therefore on the figure and then on the symbol for the layout options. A list

will be opened where you can select an option.

nN_

Layout Options X

In Line with Text

With Text Wrapping

= o T o T - 3
N —
See more...

Figure 13: Layout options of a figure

Add an alternative text in the axesWord - role mapping task pane.
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£ search

File Home axeswWord Insert Draw Design Layout References Mailings Review View Developer Help Acrobat Picture Format [V‘] Yz
<y B colorv = o Z - ] E = 0O =h P
Ed | & - . B %7 e n - Mes 3
Remove | Corrections =9 Attistic Effects v Gl v quick < At | Position Wrap E =T
Background - B Transparency »  £3 ~  Styles~ & Text v Text ¥ (Ol Selection Pane 2~ . -
Adjust Picture Styles IS Accessibility Arrange Size ] hd
o o 1o [ s 3 C4 e 5 .
- B axesWord - role mapping v X
Picture
- Role
Figures{ [ owoe
.
& Alternative text
Picture of a forest; turquoise and blue colors are predominant
-
Page9ofd  2i0words [}  English (United States)  Text Predictions: On  Bg Y% Accessibility: Good to go O Focus B ———F—+ 0%

Figure 14: Alternative text of a figure

Reason

Figures cannot be recognized by blind users. With the alternative text they
have access to the main issues of the figure.

3.6.2 Decorative elements

When a figure is a decorative element, then assign this element the Artifact role
in the axesWord - role mapping task pane.
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Figure 15: Decorative element blue shape

3.7 Lists
3.7.1  Simple lists

Type all bullet points in separate paragraphs. Then assign these paragraphs to the
paragraph style "List".
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Figure 16: Simple list with bullets
List Continue
When you want to add further paragraphs within one list entry (i. e. the further
paragraphs belong to this list entry), assign them the paragraph style "List
Continue".
Reason
After converting the document to a PDF, the list entry will have two (or more)
paragraphs and will not be divided into separate lists.
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Figure 17: Simple list with bullet points and list continue

Multilevel lists

Type all bullet points in separate paragraphs. Then assign them the paragraph
styles "List", "List 2", "List 3", "List 4" or "List 5" (for numbered lists choose the
paragraph styles "List Number", "List Number 2" etc.).
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Figure 18: Multilevel numbered list

Tip

After you have defined the first list entry with the paragraph style "List
Number" (or "List"), you can use the Tab key for the following paragraphs of
the list. Example: you have entered a list entry of level 1 and have begun a
new paragraph — now you can just press the Tab key once and write a list

entry of level 2 immediately. Please take care that you do not skip one or
more levels, because this would produce an illogical list.

3.8 Header and footer

Double click in the area of the header or footer. Now you can enter or edit text.
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Figure 19: Edit footer

To insert the page number to the footer, click in the Header & Footer command
group on the Page Number button and afterwards on the Bottom of Page
menu option. Now a menu opens and you can select one of the given formats.

3.9 Character styles

If you want to format single characters or words within a paragraph in a special
way (e. g. colored or bold) it is very useful to have character styles defined.
Character styles are applied to individual characters or words that you select. In
the Styles task pane, character styles have a lowercase letter "a" beside them.

First select the text parts you want to distinguish. Then click on a character style in
the Styles task pane, e. g. "Intense Emphasis". The selected text will be formatted
accordingly.
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Figure 20: Character style for a selected part of the text

An advantage of character styles is that you can adapt all formatted text parts in
your document at once - just modify the according character style.
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4 Create an accessible PDF document
Click in the axesWord tab on the Export PDF button.

Export PDF X

PDF file name

‘C:\Users\Puinc\Document title.pdf ‘ E

Document title

‘ Document title ‘

Main document language
| English (USA) -]

Open PDF document in default viewer
[ ] POF/A

Create | | Cancel |

Figure 21: "Export PDF" dialog box

In this dialog box you can change memory location, filename of the PDF,
document title or main language if necessary.

Click on the Create button to generate the PDF document.
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5 Checking accessibility

You can easily check if your document is accessible. Just use the PDF Accessibility
Checker (PAC): Downloadsite of PAC.
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